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What is Science anyway?

Doing Science = Acquiring Knowledge

ENEANMERE
3$j 3373' N 3&33' 33::[

Experimental Science  Theoretical Science Computational Science
» Thousand years ago > Last few centuries » Nowadays
» Observations-based » Equations-based » Compute-intensive
» Can describe » Can understand » Can simulate
» Prediction tedious » Prediction long » Prediction easier

Prediction is very difficult, especially about the future. — Niels Bohr
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Observations still base Science
Space telescope Large Hadron Collider Mars Explorer

NMR Spectroscope

Tsunamis Earthquake vs. Bridge
1 F " i /4 A‘H

(who said that science is not fun??)
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Computational Science
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Upper Atmasphere
Atmospheric Chermistry

This requires large computers

Upscale project:
15,000 computing-years in 2012!

60s 70s 80s 90s 00s 10s
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Modern Computers are Large and Complex

Massive Parallelism
» Cannot miniaturize further (atom limit)

Cannot increase frequency (energy limit)

>
» Solution: Multiply compute cores!
>

Sequoia, second fastest computer: 1,572,864 cores

ExaScale Systems, used in Computational Science
» Systems computing 1 Exaflop per second arrive (with billions of cores)
» 1 Exaflop = 10'® operations. One million million million operations. . .
> At humanly doable speed, that requires 10 times the age of the universe
» Each node: 20 millions lines of code (10x Encyclopedia Britannica)

Other very large computer systems in the wide
» Google computers dissipate 300MW on average (150,000 households, % reactor)
» Botnets: BredolLab estimated to control 30 millions of zombie computers

> In addition, these systems are heterogeneous and dynamic
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Computational Science of Computer Systems

This essential complexity mandates adapted scientific instruments

Research Field: Methodologies of Experimentation
» Assessing the performance and correctness of large-scale computer systems
» Meta-research on producing scientifically sound results
» Main contribution: SimGrid, a large-scale computer systems simulator
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Computational Science of Computer Systems

This essential complexity mandates adapted scientific instruments

Research Field: Methodologies of Experimentation

» Assessing the performance and correctness of large-scale computer systems
» Meta-research on producing scientifically sound results

» Main contribution: SimGrid, a large-scale computer systems simulator

First title (rejected)

Simulating Applications for Research in
Simulation Applications for Research

Martin Quinson Computational Science of Computer Systems Introduction €S2 SimGrid PDES  Formal Open Science Conclusion 6/30



Computational Science of Computer Systems

This essential complexity mandates adapted scientific instruments

Research Field: Methodologies of Experimentation

» Assessing the performance and correctness of large-scale computer systems
» Meta-research on producing scientifically sound results

» Main contribution: SimGrid, a large-scale computer systems simulator

First title (rejected)

La simulation d’applications pour la recherche
en applications de simulation pour la recherche
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Computational Science of Computer Systems

This essential complexity mandates adapted scientific instruments

Research Field: Methodologies of Experimentation

» Assessing the performance and correctness of large-scale computer systems
> Meta-research on producing scientifically sound results

» Main contribution: SimGrid, a large-scale computer systems simulator

First title (rejected)

Simulating Applications for Research in
Simulation Applications for Research

Martin Quinson Computational Science of Computer Systems Introduction €S2 SimGrid PDES  Formal Open Science Conclusion 4 6/30 >



Computational Science of Computer Systems

This essential complexity mandates adapted scientific instruments

Research Field: Methodologies of Experimentation

» Assessing the performance and correctness of large-scale computer systems
» Meta-research on producing scientifically sound results

» Main contribution: SimGrid, a large-scale computer systems simulator

First title (rejected)

Simulating Applications for Research in
Simulation Applications for Research

Epistemological Stance
» Empirically consider large-scale computer systems as natural objects
> Eminently artificial artifacts, but complexity reaches “natural” levels
> Other sciences routinely use computers to understand complex systems
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Assessing Distributed Applications

Correctness Study ~» Formal Methods

> Tests: Unable to provide definitive answers

Performance Study ~» Experimentation
> Maths: Often not sufficient to fully understand these systems
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Assessing Distributed Applications

Correctness Study ~» Formal Methods
> Tests: Unable to provide definitive answers

» Model-Checking: Exhaustive and automated exploration of state space

Performance Study ~» Experimentation
> Maths: Often not sufficient to fully understand these systems

Courtesy of Lucas Nussbaum

» Experimental Facilities: Real applications on Real platform (in vivo)

» Simulation: Prototypes of applications on system's Models (in silico)
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Assessing Distributed Applications

Correctness Study ~» Formal Methods

> Tests: Unable to provide definitive answers

» Model-Checking: Exhaustive and automated exploration of state space

Performance Study ~» Experimentation
> Maths: Often not sufficient to fully understand these systems

Courtesy of Lucas Nussbaum

» Experimental Facilities: Real applications on Real platform (in vivo)
» Emulation: Real applications on Synthetic platforms (in vitro)
» Simulation: Prototypes of applications on system's Models (in silico)
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Simulating Distributed Systems

Big Idea: Simulation is the fastest path from idea to scientific results

Idea to test Experimental setup ~ Simulation Model Scientific results

Comfort to the user
> Get preliminary results from partial implementations

» Experimental campaign with thousands of runs within the week

» Test your scientific idea, ignore technical subtleties (for now)
Challenges for the tools

» Validity: Get realistic results (controlled experimental bias)

> Scalability: Fast enough and Big enough; Tooling: runner, post-processing

Scientific practices sometimes unfortunate in this field
» Experimental settings not detailed enough in literature
> Many short-lived simulators; few sound and established tools
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SimGrid: Versatile Simulator of Distributed Apps

Scientific Instrument
» Versatile: Grid, P2P, HPC, Volunteer Computing and others
» Sound: Validated, Scalable, Usable; Modular; Portable
» Community-driven: 30 contributors (5 not affiliated), 5 contributed tools, GPL

Scientific Object
> Allows comparison of network models on non-trivial applications
» High-Performance Simulation on realistic workload
» Full model checker of distributed applications; Emulator under way

Large Established Project
» Started in 1998; Collab. Loria / Inria Grenoble / CC-IN2P3 / U. Hawaii
> Impact: 120 publications (110 distinct authors, 5 continents), 4 PhD
> Co-leader with A. Legrand (CNRS Grenoble) and F. Suter (CNRS IN2P3)
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Simulation Validity

SotA: Models in most simulators are either simplistic, wrong or not assessed
» PeerSim: discrete time, application as automaton;
> GridSim/CloudSim: naive packet level or buggy flow sharing
» OptorSim, GroudSim: documented as wrong on heterogeneous platforms

SimGrid provides several Network Models

v

Flow-based: Contention, Slow-start, TCP congestion, Cross-traffic effects
» Constant time: A bit faster, but no hope of realism

» Coordinate-based: Easier to instantiate in P2P scenarios

> Packet-level: NS3 bindings

[ OpenMP! SMPI (eager + overhead model)

Real Sweep3D Simulated Sweep3D
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Major Contributions (with many contributors)

1/ Proto-Emulation: Assessing Real Applications
» GRAS: Middleware to run simulation prototypes on real platforms
» SMPI: Study real MPI applications within SimGrid
2/ HPS: High Performance and Scalable Simulation
» Fast Enough: Innovative PDES; Efficient algorithms and implementations
» Big Enough: Scalable and versatile platform representation
3/ Formal: Correctness Studies in SimGrid
> Seamless integration of a complete Model Checker (enforces code invariants)

> Exhaustive reachability analysis, with innovative versatile DPOR technique

Scientific Community Management
> Project Coordinator: 2 ANR projects, 1 regional CPER project (total: 4M€)
> Methodological convergence: Board member of Grid'5000 experimental grid
» Scientific Animation (SimGrid, Grid'5000): 4 summer schools, 3 R&D engineers

+ leading role in teaching, pedagogical tools, popularization and didactic projects
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Major Contributions (with many contributors)

1/ Proto-Emulation: Assessing Real Applications
» GRAS: Middleware to run simulation prototypes on real platforms
» SMPI: Study real MPI applications within SimGrid
2/ HPS: High Performance and Scalable Simulation
» Fast Enough: Innovative PDES; Efficient algorithms and implementations
» Big Enough: Scalable and versatile platform representation
3/ Formal: Correctness Studies in SimGrid
> Seamless integration of a complete Model Checker (enforces code invariants)

> Exhaustive reachability analysis, with innovative versatile DPOR technique

Scientific Community Management
> Project Coordinator: 2 ANR projects, 1 regional CPER project (total: 4M€)
> Methodological convergence: Board member of Grid'5000 experimental grid
» Scientific Animation (SimGrid, Grid'5000): 4 summer schools, 3 R&D engineers

+ leading role in teaching, pedagogical tools, popularization and didactic projects
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Parallel Simulation of Discrete Event Systems

> 30 years of literature on efficient Simulation Engines, FES and distribution
> Yet, all DES simulator for P2P were sequential (but dPeerSim)

The dPeerSim attempt

» Distributed implementation of PeerSim
> Classical parallelization: spreads the load over several Logical Processes (LP)

P #2

LP #1

Evaluation
» Uses Chord as a standard workload: e.g. 320,000 nodes ~» 320,000 requests
» Very good speedup results: 4h on 2 LPs ~ 1h on 16 LPs
> But 47s in the original sequential PeerSim (and 5s in precise SimGrid)

> Yet, best known parallelization of DES simulator of P2P systems

Martin Quinson Computational Science of Computer Systems Introduction €S2 SimGrid PDES Formal Open Science  Conclusion 13/30



New Parallelization Schema for DES

Split at Virtualization, not Simulation Engine
» Virtualization contains threads (user's stack)

User Code

Virtualization Layer
» Engine & Models remains sequential

Simulation
Workload

Networking Models

- —
e _) Simulation Engine
t —> t —>~ t Execution
. : e  — Environment
[ = u

Understanding the trade-off

> Sequential time: Z(engine + model + virtu + user)
SR

» Classical schema: Z (max (engine; + model; + virtu; + user;) + proto)
ieLP
SR
» P d sch : 1 del jrtu; ;
roposed schema Z (englne + model + ,-E’.% (virtu; + user;) + sync)

SR
» Synchronization protocol expensive wrt the engine's load to be distributed
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Toward Parallel P2P Simulation in SimGrid
Keep models sequential, execute processes in parallel
OS-inspired Approach toward Process Separation

> Fine-locking would be difficult, inefficient and would hinder reproducibility

» Mediate any process interactions through simcalls
(conceptually identical to syscalls of real OSes)

Functional View Temporal View

u

3 @ =7 a—e—

IProcess| IProcess| IProcess| U H 2 — H :

2 T B T :

SimCall Interface U H H : :
Maestro By : o BEE : Mee

[l
£ ) : M
(| Simulation Models

Leveraging Multicores

simcall

Models+Engines

= More processes than cores ~ Worker Threads (execute co-routines ;)

SHSHSSSS Processes SEESHSSS [

Worker ‘ ‘ Worker‘ ‘ Worker

Maestro ! {
Simulation Models L

o
£
7]

2

Functional View

Temporal View

[ : o fetch_add()
oo o futex_wait()
i T, b soso—pow wfutex_wake()

Ideal Algorithm
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Sequential Performance in State of the Art

» Scenario: Initialize Chord, and simulate 1000 seconds of protocol

» Arbitrary Time Limit: 12 hours (kill simulation afterward)
Largest simulated scenario

40000 : :
+ OverSim (OMNeT++) —@—
PeerSim —5— |
OverSim (simple underlay) —e— |
| SimGrid (sequential) —<— |
SimGrid (4 threads) - > -
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Number of nodes

Size | Time

Omnet++ | 10k | 1h40
PeerSim | 100k | 4h36
OverSim | 300k | 10h
10k | 130s

SG, precise | 300k | 32mn
2M | 6h23

SG, simple | 2M | 5h30

:Memory Usage

» 2M precise nodes: 32 GiB
» That is 18kiB per process

(User stack: 12kiB)

Extra complexity of parallel execution don't impact sequential performance
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Benefits of the Parallel Execution

1 thread —ol—
[ 2threads —<—
13 4 threads ——
8 threads —5—
16 threads ——

| 24threads —e—/._/_{_a
; —_=

Speedup (precise model)

Speedup (constant model)

Parallel Efficiency (Speed”p) for 2M nodes

500000 1e+06 1.5e+06

Number of nodes

2e+06

» Speedup (t”q): up to 45%

» More efficient with simple model:

> Less work in engine + Amhdal law

» Speedup depends on thread amount

> 8 threads (of 24 cores) often better
> Synch costs remain hard to amortize
» They depend on thread amount

» Baaaaad efficiency results

Model 4 threads | 8 th. | 16 th. | 24 th.
Precise 0.28 0.15 0.07 0.05
Constant 0.33 0.16 0.08 0.06

» Remember, P2P and Chord:
Worst case scenarios

Yet, first time that Chord's parallel simulation is faster than best known sequential

Martin Quinson
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Future Work on HPS

Distributed Simulation toward size

> Leverage the memory of more nodes; Useless in P2P, more adapted to SMPI

Design: split our design under the simcall layer

Functional View Temporal View

‘
SimCall SimCall - BNz : iz
|Repetitore| |Repetitore| : Né zj%é
|| ' Ak
Network Mo L o ‘ —EE
O simcall ]
< Maestro equestiE 4 ane -
©| Simulation Models & m Us

Increase level of parallelism

> Pessimistic execution (as now): efficient for 500,000 processes and more. . .
» Optimistic execution unfeasible because of our complex state

» Vision: realistic execution run optimistically only if it is safe to do so
Determining independent actions is easy using formal methods
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Major Contributions (with many contributors)

1/ Proto-Emulation: Assessing Real Applications
» GRAS: Middleware to run simulation prototypes on real platforms
» SMPI: Study real MPI applications within SimGrid
2/ HPS: High Performance and Scalable Simulation
» Fast Enough: Innovative PDES; Efficient algorithms and implementations
» Big Enough: Scalable and versatile platform representation
3/ Formal: Correctness Studies in SimGrid
> Seamless integration of a complete Model Checker (enforces code invariants)

> Exhaustive reachability analysis, with innovative versatile DPOR technique

Scientific Community Management
> Project Coordinator: 2 ANR projects, 1 regional CPER project (total: 4M€)
> Methodological convergence: Board member of Grid'5000 experimental grid
» Scientific Animation (SimGrid, Grid'5000): 4 summer schools, 3 R&D engineers

+ leading role in teaching, pedagogical tools, popularization and didactic projects
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Exhaustive Testing for Correctness Formal Assesment

Model Checking's Big Idea

» Explore all possible executions of the system

> Actively searching for property violations

=

Testing can only prove the presence of bugs. — Dijsktra

well, unless it's exhaustive :)

Martin Quinson Computational Science of Computer Systems. Introduction €S2 SimGrid PDES Formal Open Science  Conclusion 20/30



Model Checking in Wonderland

A warrior seeks her prince. &
She can grab *, grab ®, move =, move «. * {

Model checking: Actively search for a counter example
» If not found, then the property was true after all

> If found, we got a counter-example (very precious during bug squashing)

Safety Property: o(- #) Liveness Property: o((» A ®) = < #)
» Search an invalidating state » Search a cycle w/ property is false

» Exhaustive traversal: property true  » Counter-example is infinite
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The Problem with Model Checking

| use programs, not models

» Model-checking usually done on logical models, e.g. expressed with TLA™
> Some technics require the full graph, that | never have
= Explicit exploration of Implicit graph is called Dynamic Verification
Liveness Properties
> Nice properties are liveness ones, not safeties, but that's much harder

» Counter example must be of infinite length, so encoded as Buchi automaton

@ + Any process that asks the critical section will get it

Ces &l > r: request
[ Y]
O/o 3/5 > cs: critical section
Q
?J » LTL property: O(r = <cs)
State-space Explosion

. . 100 . .
» Nice problems require 22 years in practice (or more)
> Several reduction technics exists, but preserving cycles is harder
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Dynamic Verification in SimGrid

Verifying safety properties
> It works (MSG & SMPI); Reduction with DPOR-based reduction techniques

» Found wild bugs in medium-sized programs (Chord protocol)

Verifying liveness properties (ongoing)
> Problem: detect when the system reenters an (accepting) state

» We need system-level state equality

Kernel space ,
/
/ BSS
l Stack / Dt
. fibe.s
/ Internal data
/
/ Text
Memory Mapping Segment Arommous mapsing » Byte-per-byte comparison
Dynarmic libraries BsS . .
ineffective
User mode space n promrpy (Rt
N .
T . | > Lots of false negatives
eap \ . .
\ oo s (aka undetected violations)
BSS segment \
Uninitialized static variables
Data segment
Initialized static variables
Te .
ext segment — Dynamic system state
Computational Science of Computer Systems Introduction €S2 SimGrid PDES Formal Open Science  Conclusion 23/30
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Challenges of System-level State Equality

Over provisioning

fragment size 256 256 512 1024 256 256 1024 512
AR [//////////////// 70077777777, ‘
2000 s Vesass 1000000000707077 2IaN 0T
AR A YIa 0000057

size used 240 200 400 924 256 648

Syntactic differences

» In malloc, blocs order can vary without impacting applicative semantic

P RN

- NI

0x500 ‘ '

' ‘

]

0100 [123456] [ 0x200 [ asav |

» s
U><3EID‘ gec ‘ ‘Ox-’JOO

‘ 0x100 123456‘ ‘ 0x200 | aSd25 ‘ ‘ 0x300 ‘ ffe ‘ ‘ 0x400 ‘ gee ‘ ‘ 0x500
A ~

Padding Bytes

» Data is aligned in memory for efficiency, leaving holes

Irrelevant differences
> Host-related data (pid, files), simulation-related data (time)
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Toward Liveness Properties in SimGrid

System Solutions to this Formal Problem

| Problem | Heap solution | Stack solution \
Over provisioning Memset 0 + requested size | Stack pointer
Padding bytes Memset 0 DWARF + libunwind
Irrelevant differences MC_ignore DWARF + libunwind
Syntactic differences Canonicalization N/A

Current state
» Toy artificial bugs found; Toy property on non-tivial code (NeverJoin in Chord)

» State equality gives a new reduction that works on liveness, too

Future
» MPI3 asynchrone collective operations are a call for semantic bugs
> Assessing properties on communication schema toward easier checkpointing
> Assessing linearizability (service is robust to concurrent usages)

» Explore specific reduction techniques for distributed apps
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Take Away Messages

SimGrid will prove helpful to your research
> Versatile: Used in several communities (scheduling, GridRPC, HPC, P2P, Clouds)
» Accurate: Model limits known thanks to validation studies
» Sound: Easy to use, extensible, fast to execute, scalable to death, well tested
» Open: User-community much larger than contributors group; LGPL

» Around since over 10 years, and ready for at least 10 more years

Welcome to the Age of (Sound) Computational Science

» Discover: http://simgrid.gforge.inria.fr/

SlM R|D » Learn: 101 tutorials, user manuals and examples

» Join: user mailing list, #simgrid on irc.debian.org
We even have some open positions ;)
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http://simgrid.gforge.inria.fr/

The Computational Science Nightmare

Computational Science is rarely Reproducible!
» Scientific publications must include all information needed for reproduction
» Knowledge is not the finding, but the method. — Boyle

Issue shared with other scientific disciplines
» Why Most Published Research Findings are False. loannidis, PloS Med, 2005.
» Reproducibility in Computational and Experimental Maths workshop, 12/2012

JASA June ‘ Computational Articles Code Available

1996 9 of 20 0%

2006 33 of 35 9%

2009 32 of 32 16% ,
2011 29 of 29 21% V. Stodden

Non-CS major will teach us about Computational Science!

(inspired from Victoria Stodden, Department of Statistics, Columbia University)
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Open Science, and CS?

Required Tools

v

Standard tools: Matlab, R in statistics, . ..
Dissemination Platforms: RunMyCode.org

Workflow Tracking and Research Environments: VisTrails, MyExperiment.org
Embedded Publishing: Sweeve

vV v v

v

Journal Policy: Things evolve veeeery slowly

My Research Plan

» SimGrid is a standard tool; use it as troyan to pass best practices along

Ease experiment packaging and sharing

»
> Increase associated tools (adaptative runners) to increase the incentive
» Improve our own best practices within the team

>

Learn from other disciplines, and build upon this
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Conclusion

Scientific Instruments for Distributed Systems

» Common Belief in 2008: Simulation as a toy methodology

log(cost + coordination)

Grid’5000
DAS3
Major challenge PlanetLab

Data Grid eXplorer

WANinLab RAMP
Emulab Dave Patterson’s
SimGrid Project on Muticore
MicroGrid Multi-processor emulator
Reasonable
Model NS,
Protoc roof

1 I 1 1 > |og(realism)
math simulation emulation live systems

Courtesy of Franck Cappello (Gri5000 keynote @ EGEE, Feb 2008 :)

Martin Quinson
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Conclusion

Scientific Instruments for Distributed Systems
» Common Belief in 2008: Simulation as a toy methodology
» Consensus in 2013: SimGrid as a scientific instrument (w/ Grid’5000)

log(cost + coordination)

Grid’5000
DAS3
Major challenge PlanetLab

Data Grid eXplorer
WANinLab

RAMP
Emulab

Dave Patterson’s
Project on Muticore
Multi-processor emulator

[ ]
X )

Reasonable SimGrid
Model NS,
Protoc roof
I I I I > log(realism)
math simulation

emulation live systems

Simulation turned into a reliable scientific instrument!

Martin Quinson
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Conclusion
Scientific Instruments for Distributed Systems

» Common Belief in 2008: Simulation as a toy methodology

» Consensus in 2013: SimGrid as a scientific instrument (w/ Grid’5000)
» Consensus in 20207 We were naive in 2010, but it works better now

log(cost + coordination)
Grid’5000
DAS3

PlanetLab

Major challenge

Data Grid eXplorer
WANinLab
Emulab

Dave Patterson’s
Project on Muticore
Multi-processor emulator

[ ]
X )

[ ]
Reasonable SimGrid
Model NS,
Protoc roof
1 I 1 I > |log(realism)
math simulation emulation live systems

Simulation turned into a reliable scientific instrument!

But there is still a long way to go!
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Research Program

Computational Science of Computer Systems
pursued convergence of Simulation, Dynamic Verification and Emulation

1/ Modeling of Large-Scale Systems
» Scalability and Accuracy still not enough for Exascale studies

» Semantic modeling of MPI 3.0 collectives (implementation-depend)

2/ Formal Methods for Large-Scale and HPC Systems
> Liveness properties on legacy code (OS-level introspection tooling)

» Domain-specific properties and reduction techniques

3/ Simulation of Real Applications
> OS Virtualization layer for the simulation of legacy code

» Distributed simulation, and increase parallelism in our simulation

4/ Scientific Instrument and Open Science
» Produce a de facto standard tool, with associated tools
> Foster the emergence of a vivid research community, with best practices
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Question slides
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What is Science anyway?
Doing Science = Acquiring Knowledge

]

Experimental Science Computational S

> Thousand years ago > Last few centuries

» Can describe
> Prediction tedious

> Can understand
» Prediction long.

> Can simulate
» Prediction easier

Prediction is very diffcul, especially about the future. ~ Niels Bohr

Obser

servations still base Science
Space telescope Large Hadron Collder

Mars Explorer

S

NMR Spectroscope Synchrotrons

nal Science

This requires large computers
Upscale project
15,000 computing years in 20121

o it s 0 ) ) oo

ey e e e e e T = [T T—r————— = p—r—T—— n
Modern Computers are Large and Complex C Science of Computer Systems Assessing Distril icati

Massive Parallelism

> Cannot miniaturize further (atom limit)
> Cannot increase frequency (energy limit)
> Solution: Multiply compute cores! ~
> Sequoia, second fastest computer: 1572864 cores
ExaScale Systems, used in Computational Science
> Systems computing 1 Exaflop per second arrive (vith billons of cores)
» 1 Exaflop = 10% operations. One millon millon millon operations.
» At humanly doable speed, that requires 10 times the age of the universe.
» Each node: 20 millons lines of code (10 Encyclopedia Britannica)

Other very large computer systems in the wide

» Google computers dissipate 300MW on average (150,000 househalds,  reactor)

This essential complexity mandates adapted scientific instruments

Research Field: Methodologies of Experimentation
> Assessing the performance and correctness of large-scale compr
> Meta-research on producing scientifcally sound results

er systems

> Main contribution: SimGrid, a large-scale computer systems simulator

First title (rejected)
Simulating Applications for Research in
Simulation Applications for Research
Epistemological Stance

» Empirically consider large-scale computer systems as naturl objects

Correctness Study ~ Formal Methods
> Tests: Unable to provide defiitive answers

» Model-Checking: Exhaustive and automated exploration of state space

Performance Study ~» Experimentation
> Maths: Often not suficent to fully understand these systems

a E v

> Experimental Faciltes: Real applications on Real platform

(i viv)

» Eminently artifcal artfacts, but complexity reaches “natural” levels > Emulation: Real applications on Synthetic platforms (in vitr)
> Botnets: BredoLab estimated to control 30 milions of zombie computers > Other siences routinely use computers to understand complex systems > Simulaton: Prototypes of applications on system's Models (in siico)
> n addiion,thess sy are hetsrgeneos and dymamic

e i o e e o o e Ty ey [ T T2 r=rr— e e e e e Ty

Simulating Distributed Systems SimGrid: Versatile Simulator of Distril Apps i Validity

Big Idea: Simulation is the fastest path from idea to scientific results

Idea to test Experimental setup

+

Simulation Model

Scientifc results

Comfort to the user
> Get preliminary results from partial implementations.
> Experimental campaign with thousands of runs within the week
» Test your scientfc idea, ignore technical subtletes (for now)
Challenges for the tools
> Validity: Get realistc results (controlled experimental bias)
> Scalabilty: Fast enough and Big enough: Tooling: runner, post-processing
Scientific practices sometimes unfortunate in this field
> Experimental settings not detailed enough in literatur
» Many shor e imutors. o sound and sablished tools

T —p———T

Scientific Instrument
» Versatile: Grid, P2P, HPC, Volunteer Computing and others
> Sound: Validated, Scalable, Usable; Modular: Portable
» Community-driven: 30 contributors (5 not affifated). 5 contributed tools, GPL
Scientific Object
> Allows comparison o netvork madels on non-trival applications.
> High-Performance Simulation on realistic werkload
> Full model checker of distributed applications; Emlator under way
Large Established Project
> Started in 1998; Colab. Loria / Inria Grenoble / CC-IN2P3 / U. Hawai
» Impact: 120 publications (110 distnet authors, 5 continents), 4 PhD.
» Coleader with A. Legrand (CNRS Grenoble) and F. Suter (CNRS IN2P3)

SotA: Models in most simulators are ither simplisic, wrong or not assessed
» PeerSim: discrete time, applicaton 35 automaton;

> Grdim/CloudSim: naive packet level or bugay flow sharing

» OptorSim, GroudSim: documented a5 wrong on heterogencous pltforms

SimGrid provides several Network Models
» Flow-based: Contention, Slow-start, TCP congestion, Cross-traffc effcts
» Constant time: A bit faster, but no hope of realism
» Coordinate-based: Easier to instantiate in P2P scenarios
» Packetlevel: NS3 bindings

Real Sweep3D

P T T

Simulated Sweep3D




Major Contributions (with many

New lization Schema for DES

Parallel of Discrete Event Systems

1/ Proto-Emulation: Assessing Real Applications
> GRAS: Middievare to run simulation prototypes on real platforms
» SHMPL Stucy real MPI appiications within SimGrid
2/ HPS: High Performance and Scalable Simulation
» Fast Enough Innovative PDES; Eficient algrithms and implementations
» Big Enough: Scalable and versatle platform representation
3/ Formal: Correctness Studies in SimGrid
> Seamless integration of a complete Model Checker (enforces code invariants)
» Exhaustive reachability analyss, with innovative versatle DPOR technique.
Scientific Community Management
» Project Coordinator: 2 ANR projects, 1 regional CPER project (total: 4MI€)
» Methodological convergence: Board member of Grd'5000 experimental grid
> Scientifc Animation (SimGrid, Gid'5000): 4 summer schools, 3 R&D engincers

+ leading role i teaching, pedagogical tools, popularization and didactic projects.

=30 years of lterature on efficent Simulation Engines, FES and distribution
> Yet. all DES simulator for P2P were sequentil (but dPeerSim)

The dPeerSim attempt
> Distributed implementation of PeerSim
» Classical paraleization: spreads the load over several Logical Processes (LP)

Evaluation
> Uses Chord 25 3 standard workload: <5, 320,000 nodes ~ 320,000 requests.
» Very good speedup resuts: 4h on 2 LPs ~- 1h on 16 LPs
> But 475 in the orginal sequential PeerSim (and Ss in precise SimGrid)
> Yet, best known paraleization of DES simulator of P2P systems

Split at Virtualization, not Simulation Engine
» Virtalization contains threads (user's stack)
» Engine & Models remains sequential

v [T e A8

Understanding the trade-off
> Sequenial time: Y (engine-+ model + virtu + user)
w

» Classical schema: max (engine; + model; + virtu; + user;) + proto
3 (paste vt )+ roto)

> Proposed schema: 3 (.ng.,,” mode + max (vt .MHW)

3
» Synchronization protocol expensive wt the engine’s load t0 be distributed

e et

Toward Parallel P2P Simulation in SimGrid
Keep models sequential, execute processes in parallel
OS-inspired Approach toward Process Separation
- me.n. would be diffcult, ineficent and would hinder

producibilty
Mediate weracionsthough sl

(conceptunty enticl to syscls of rel 05es)
Functional View Tempmal View

EEE=E= h

L=

Leveraging Multicores
= More processes than cores - Worker Threads (execute co-routines ;)

P ! P s
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in State of the Art

» Scenario: Intiaize Chord, and simulate 1000 seconds of protocol
> Arbitrary Time Limit: 12 hours (kil simulation afterward)
Largest simulated scenario

- [Memory Usage

> 2M precise nodes: 32 GiB.

» That is 18Ki8 per process
(User stack: 12kiB)

Benefits of the Parallel Execution

> Speedup (32): up to 45%
» More efficient with simple model
> Less work in engine - Amhdal law
» Speedup depends on thread amount.
> threads (of 24 cores) often better
7 Sy cos rrahardtoserion
> They depend on thread amount

Paralll Efficiency (Z542) for 2M nodes

» Basaaad efcency results

» Remenbr P20 o Chord
st case scenarios

Yet, first time that Chord's parallel simulation is faster than best known sequential

mm.m View _Tempos Vi Ideal Algorithm

Extra compleity of paralel sxecution don't impact sequential peromance_

Future Work on HPS

Distributed Simulation toward size
> Leverage the memary of more nodes; Usless in P2P, more adapted to SMPI
Design: split our design under the simcall layer

Functional View

Temporal View

A

Siston odes

Increase level of parallelism
> Pessimistic execution (a5 now): eficent for 500,000 processes and more.
» Optimistc execution unfeasible because of our complex state
> Vision: realistc exceution run optimistically only f it i safe to do so
Determining independent actions is casy using formal methods.

Liveness Property: 0((- 4 9) = © %)
> Search 3 cycle w/ propery is fase

Testing for C Formal Model Checking in
Model Checking’s Big Idea A varior seeks her prince.
> Explore all possible executions of the system She can grab ., grab 9, move =, move .
» Actvely seaching for property violations
Model checking: Actively seatch for a counter example
» 1 ot found, then the property vas tre afer all
> I found, we got counter-example (very precious during bug squashing)
Safety Property: 0(- +)
Testing can only prove the presence of bugs. — Dijsktra » Exhaustive traversal: property true

» Counter-example is infinite

well, unless it’s exhaustive -)




> Several reduction technics exists, but preserving cycles is harder

The Problem with Model Checking
1 use programs, not models
> Modekchecking usually done on logical models, <5, expressed with TLA*
> Some techics require the full graph, that | never have
- Explict exploration of Implict graph i called Dynamic Verfcation
Liveness Properties
> Nice properties ae liveness ones, not safetis, but that's much harder
» Counter example must be of infiite length, so encoded 2s Buchi automaton

Any process that asks the critical section will get it

U U popeny: or = o)
State-space Explosion

> Nice problems require 22 years in practice (or more)

Dynamic Verification in

Verifying safety properties
> It works (MSG & SMPI); Reduction with DPORbased reduction techniques
» Found wild bugs in medium-sized programs (Chord protocol)

Verifying liveness properties (ongoing)

> Problem: detect when the system reenters an (accepting) state
> W need system-level state equality

> Byte-per-byte comparison
ineffective

> Lots of false negatives
(aka undetected violations)

Challenges of System-level State Equality

Over provisioning

Syntactic differences

> In maloc, blocs order can vary without impacting applicative semantic

Padding Bytes
> Data is aligned in memory for efcienc

leaving holes
Irrelevant differences
> Host-related data (pid, fils), simulation-related data (time)

T ET

s in SimGi

Toward Liveness Proper

System Solutions to this Formal Problem

[ Stack somtion |

DWARF  Toumwind

Syntactic differences

Canonicalization

Take Away Messages

SimGrid will prove helpful to your research
» Versatile: Used in several communities (scheduling, GridRPC. HPC, P2P, Clouds)
» Accurate: Model limits known thanks to valdation studies
> Sound: Easy to use, extensibl, fast to exccute, scalable to death, well tested

Current state
> Toy anifical bugs found; Toy property on non-tivil code (NeverJoin n Chord)
> State equality gives a new reduction that works on ivenes, to0
Future
> MPI3 asynchrone collective operations are a cal forsemaniic bugs
» Assesing properties on communication schema toward easier checkpointing.
> Assesing ineaizablty (senvice is robust to concurrent usages)

» Explore specifc reduction techniques for distributed 3pps

> Open much larger than conributors group; LGPL
> Around since over 10 years, and ready for 3t least 10 more years

Welcome to the Age of (Sound) Computational Science
» Discover. http: //simgrid gforge. inria.tr/
> Jon: e maing lst, simgrid o icdebianorg

en have some open positons )

The Computational Science Nightmare

Computational Science is rarely Reproducible!
» Scientifc publications must include allinformation needed for reproduction
> Knowledge is not the fnding, but the method. ~ Boyle

Issue shared with other scientific disciplines
> Why Most Published Research Findings are Fafse. loannidis, PloS Med, 2005
> Reproducibility in Computational and Experimental Maths workshop, 12/2012

V. Stodden
Non-CS major wil teach us about Computational Science!

(imspied rom Viteris Stekden, Departmentof Staistc, Colmbia Universy)

e e e e e T
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Open Science, and CS?

Required Tools
» Standard tools: Matlab, R in statistcs
» Dissemination Platforms: RunMyCode.org
» Worklow Tracking and Research Environments: VisTrail, MyExperiment org
> Embedded Publishing: Sweeve

» Journal Policy: Things evolve veeeery slouly

My Research Plan
> SimGrid is a standard tool; use it 25 troyan to pass best practices slong
» Ease experiment packaging and sharing.
> Increase associated tools (adaptative runers) to increase the incentive
> Improve our own best practices within the team
> Learn from other discipines, and build upon this

Conclusion
Scientific Instruments for Distributed Systems
» Common Belief in 2008: Simulation as a toy methodology
> Consensus in 2013: SimGrid as a scientific instrument (w/ Grid'5000)
> Consensus in 20207 We were naive in 2010, but it works better now

B ——
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Simulation tured into a reliable scientfic instrument!

But there is still a long way to go!

Research Program
Computational Science of Computer Systems
pursued convergence of Simulaton, Dynamic Verifcation and Emulation

1/ Modeling of Large Scale Systems

> Scalabilty and Accuracy still not enaugh for Exascale studies

> Semantic modeling of MPI 3.0 colectives (implementation-depend)
2/ Formal Methods for Large-Scale and HPC Systems

> Liveness propertis on legacy code (OS-level introspection tooling)

> Domain-specifc propertes and reduction techniques
3/ Simulation of Real Applications

» O Virtualization laer for the simulation of legacy code

> Distributed simulation. and increase paralllism in our simulation
4/ Scientific Instrument and Open Science

> Produce 2 de facto standard tool, with assaciated tools

» Foster the emergence of a vivid research community, with best practices

e T S ET




Question slides

Emulating Large-Scale Applications

Execute your application in a perfectly controlled environment
> Real platforms are not controlabl, 5o how to achieve this?
> Let's ook at what engineers do i other felds

When you want to build a race car.

GRAS (Grid Reality And Simulation)

Personal Use: develop real applications within the simulator
et orvogrent nch & Dol

Without GRAS

Wi GRAS

Develop Once, Deploy Twice

 Deveop and tune n the simulator, Deploy n st withou madfication

adapted to wet tracks _.in a dry country you can simulate it How: One APL o implementations

But then, you have " ; Grid Runtime Environment (result = application # prototype)
> To assess models ‘i‘,;h“w » Performance: efficient wire protocol fo structured data
» Technical burden - <] » Portable: across OSes, across CPU architecture, zero dependency
> No real car

ut this forces an AP to the users!
Why don't you st control the cimte? or tweak the car's reaity? But this f APl to th

i MPI: Sis real MPI licatie

SMPI Future Work

Online simulation of unmodified MPI application within SimGrid
> Algorithm prototyping; Platform dimensionning; What-f analysis

PB 1: Enable this mode of MPI execution
» (partially) Reimplement MP1 on top of SimGrid
> Fold MPI processes as threads
> Allow to manually factorize data memory

Improve the enabling of MPI simulation
> Passes (almost) all MPICH tests
> Privatization of variable stil difficult ~- separate MPI processes
> Simulate 10° MPI Linpack processes within SimGrid?
> Distribute simulation to achieve this size-up.

Push the validity limit further
> Validiy s acceptable on simple examples
> Further improve the modeling of one-to-one communications
» Madel global communications. (OpentPl vs. MPICH?)

Quick Overview of Internals O

User-visible SimGrid Components
» MSG: heuristics as Concurrent Sequential Processes (Java/Ruty/Lua bincings)
> SimDag: heuristcs as DAG of (paralle) tasks
> SMPI: simulate real applications written using MPI

> Simix: Processes, synchronizations.

i

POz s ot * Model CPU and memoy perfornance (vith MESCAL team) " Stnr S s e [ $$ ==
Accurate aso for small messages Vision > Models: Compute completon dates | 3 | [ X se
» ANR SONGS project coordinates these efforts (tool versatlty considered helpful) o T

Simulation Versatility should not hinder Scalability
» Two aspects: Big enough (large platforms) @ Fast enough (large workload)

Versatile yet Scalable Platform Descriptions
> Hierarchical organization in ASes
~ cuts down complexity
- recursive routing
> Effcient on each classica structures
Fla, Floyd, Star, Coordinate based
> Allow bypass at any level
- Grid'5000 platform in 22KIB
(10'ites, 40 clusters, 1500 nodes)
King's dataset in 200Ki8.
(2500 nodes, coordinate based)

Visualizing SimGrid Simulations

Jization scriptable: easy but powe

> Right Information: both platform and applicative visualizations

I configuration; Scalabe tools

> Right Representation: gantt charts, spatial representations, tree-graphs
> Easy navigation in space and time: selection, aggregation, animation
> Easy trace comparison: Trace difing (sl partal ATM)

Other Associated Tools

Prepare the experimental scenarios
Launch thousands of simulations
Post-processing and result analysis
~ Each simulation s only 3 brick

Workload Generation
> Platforms: Simulacrum (generation), PDA (archive) and MintCAR (mapping)
> Applicative Workload: Tau-based trace collction + replay

e
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Max-Min Fairness between Network Flows

=02

Computing the sharing between flows

> Objective functon: msimize in(ss) [Massouié & Rabert 2003]

0 < Power CPU,  (12)
o+ < Power CPU, (1b)
it < Power ok, (16)
Pt < Powerinky (1)

> Eaquiibrium: increasing any pr decreases a o}, (with py > )
> (actually, that's a simplification of our real objective function)

Efficient Algorithm
S o e o i st €~ (1.2}

2 This dtemines any fow  onthis ik 3 = &
3 Updte all m ad  t removethese flows Loop uncall  are e

Max-Min Fairness Example

Homogeneous Linear Network

[@1
tow

> Alllnks have the same capacity €

> Each of them is limiting. Let's choose link 1
= o= Cl2and = CJ2

> Remove flows 0 and 1; Update links’ capacity
> Link 2 sets gy = C/2

> We are done computing the bandwidths p;

Efficient Implementation
> Lazy updates, Trace integration, preserving Cache localty

The CPU model
Modeling computations in SimGrid
Py

a Nutshell

rate R in Mflop/s & Computation = amount A of Flops ~ Time = A/R
Simulation kernel main loop

Some actions get created (by application) and assigned to resources
Compute share of everyone (resource sharing algorithms)

Compute the earlies fnishing action, advance smulated time to that time.
Remove finished actions.

Loop back to 2

f
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How big and how fast? (1/3 - G

and VC)

How big and how fast? (2/3 - P2P)

Comparison to GridSim
A master distributes 500,000 fixed size jobs to 2,000 workers (round robin)
GridSim SimGrid

Network model | delay based model

Topok none Grids000
ime 145
Memory. 4468 16518

Volunteer Computing settings
» Loosely coupled scensrio as in Boinc.
> SimGrid: full modeling (clients and servers), precise network model
> SImBA: Servers only, descisions based on simplistic markov modeling
- SimGrid shown 25 times faster

> Scenario: Initalize Chord, and simulate 1000 seconds of protocol
> Arbitrary Time Limit: 12 hours (kil simulation afterward)

GO e =] Largest simulated scenario

§ 00, S ot S
i ety

E 200

f oo

TR0 Ter T5er0h T8

> Orders of magnitude more scalable than state-of-the-art P2P simulators
> Precise model incurs 3 = 20% slowdown, but accuracy is not comparable
> Also, parallel simulation (faster simulation at scale); Distrbuted sim. ongoing,

How big and how fast? (3/3 - HPC)

Simulating a binomial broadcast

o Modet
" > SimGrid: contention + eabinets
Werarchy
E o » LoGGOPSm: simple delay-based model
i Resuts
I > SimGrid i roughly 75% s
o woarim |+ SimGrid is about 20% more ft
Yoty —— (1568 required for 2 processors)

Lo o P

The genericity of SimGrid data structures comes at the cost of a slight overhead
BUT scalabilty does not necessarily comes at the price of realism

e e e e Tl

Contributions to Facilities (in vivo)

One to Rule Them All

Grid'5000 Project: world leading scientific instrument for dist. apps
> Instrument for resarch in computer cience (deployment of cstomized OSes)
1500 nodes (2600 cus, 200 core), 9 stes; ddicated 10G netverk

Personal Contributions
> National steering comittee; Local project co-leader (CPER, Aladdin, Hemera)
» Scientifc animation, event co-organization: Nancy is 3 leading site
» Collsboration: Production grids (1dG), CEA, Arcelor-Mittal

Project: Experimentaton Process Industrialzatio (with L. Nussbaum)
> Open sience: ensure that expeimens can be shred, reviewed, improved

» Comvergence of simlation and diect execution

> Methodolgics rameusk and pracicl ools

Reality 2 oersanding.
pothsi

e
o Experiment descrtion

Sciences Manuelles du Numérique
> Faire des activités d'initation 3 Ia science informatique.
> Pour la fate de la science, pour les TS (1/3 du temps hors machine)
> Boolier: Codage binaire de linformation, code correcteur, transmission
> Crépier psycho-rgide: Notion dalgorithme, ti
» Base-ball coloré: Algorithme, algorithme efficace, algorithme correct
» Robozzle: Programmation (instruction, bouce, fonction)

e e e e T
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Emulating Large-Scale Applications

Execute your application in a perfectly controlled environment
» Real platforms are not controllable, so how to achieve this?

> Let's look at what engineers do in other fields

When you want to build a race car. ..

...adapted to wet tracks ...in a dry country ...  ...you can simulate it.

But then, you have

wneqssnp seanT jo Asauno)

» To assess models
» Technical burden

» No real car

Why don’t you. .. just control the climate? or tweak the car's reality?

Martin Quinson Computational Science of Computer Systems Introduction €S2 SimGrid PDES Formal Open Science  Conclusion 4 32/30 >



GRAS (Grid Reality And Simulation)

Personal Use: develop real applications within the simulator

Research Development Research & Development

Code -
i rewrite

Simulation Application Simulation  Application

Without GRAS With GRAS

Develop Once, Deploy Twice

» Develop and tune on the simulator; Deploy in situ without modification

Martin Quinson Computational Science of Computer Systems Introduction €S2 SimGrid PDES Formal Open Science  Conclusion 33/30



GRAS (Grid Reality And Simulation)

Personal Use: develop real applications within the simulator

Research Development Research & Development

Code

rewrite
i i GRAS

Simulation Application

Without GRAS With GRAS

Develop Once, Deploy Twice

» Develop and tune on the simulator; Deploy in situ without modification
How: One API, two implementations

Grid Runtime Environment (result = application # prototype)

» Performance: efficient wire protocol for structured data

» Portable: across OSes, across CPU architectures, zero dependency

But this forces an API to the users!
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Simulated MPI: Simulating real MPI applications

Online simulation of unmodified MPI application within SimGrid
> Algorithm prototyping; Platform dimensionning; What-if analysis ...

PB 1: Enable this mode of MPI execution
> (partially) Reimplement MPI on top of SimGrid
» Fold MPI processes as threads

» Allow to manually factorize data memory

PB 2: Useless if not realistic enough

» Improve model ~ piece-wise linear model
Accurate also for small messages

> Preserve good modeling of network contention
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SMPI Future Work

Improve the enabling of MPI simulation

> Passes (almost) all MPICH tests

» Privatization of variable still difficult ~ separate MPI processes
» Simulate 106 MPI Linpack processes within SimGrid?

» Distribute simulation to achieve this size-up

Push the validity limit further

» Validity is acceptable on simple examples

» Further improve the modeling of one-to-one communications

> Model global communications (OpenMPI vs. MPICH2)
» Model CPU and memory performance (with MESCAL team)
Vision

> Be the best alternative to simulate ExaScale Systems

> ANR SONGS project coordinates these efforts (tool versatility considered helpful)

Martin Quinson Computational Science of Computer Systems Introduction €S2 SimGrid PDES Formal Open Science  Conclusion 35/30



Quick Overview of Internals Organization

User-visible SimGrid Components

» MSG: heuristics as Concurrent Sequential Processes (Java/Ruby/Lua bindings)

» SimDag: heuristics as DAG of (parallel) tasks

» SMPI: simulate real applications written using MPI

User Code
MSG SMPI SIMDAG
App. spec. as
SIMIX . App. spec. as concurrent code ||tk &r2Ph
SimGrid internal layers Concurent
processes
» MSG: User-friendly syntactic sugar S;i"sﬂ‘;é’eions{
» Simix: Processes, synchronizations
) work [ 435 | 530 664 245 Platform
» SURF: Resources usage interface o (2] |50 |50 - (205 AC"V“‘“ Description
variable
» Models: Compute completion dates <o
<G -
<G, =
X3 + X SCL,., -
. B 1=
SURF Variables Resource
Constraints
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SimGrid Scalability

Simulation Versatility should not hinder Scalability

» Two aspects: Big enough (large platforms) @ Fast enough (large workload)

Versatile yet Scalable Platform Descriptions

» Hierarchical organization in ASes

Ast1

. —0
~ cuts down complexity Ful P, 2O fc?f’f%s
i i HHENIRVS T
~> recursive routing B
1]

» Efficient on each classical structures - /
Flat, Floyd, Star, Coordinate-based N\

» Allow bypass at any level ~(ass

Full @A '
| Rule—
~> Grid'5000 platform in 22KiB i - St
(10 sites, 40 clusters, 1500 nodes) Pue, was | he T[T S
. , . . i 11 1l 11 11 [N
~ King's dataset in 290KiB seeei o)) CEESESSY SESENSNY

(2500 nodes, coordinate-based)
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Visualizing SimGrid Simulations

Visualization scriptable: easy but powerful configuration; Scalable tools
Right Information: both platform and applicative visualizations
Right Representation: gantt charts, spatial representations, tree-graphs

Easy navigation in space and time: selection, aggregation, animation

vV vV.v. v Yy

Easy trace comparison: Trace diffing (still partial ATM)

Jiil

|
[HHHHI

AKY-SMPI

AKY-OMPI _
' 7

A DRARASR

TAU-OMPI

=S ==
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Other Associated Tools

Workflow to any Experiments through Simulation

1. Prepare the experimental scenarios | Scemario i1 Simulator - Quipuis !
H H ! Laput - Usey J D Textual lo !

2. Launch thousands of simulations | _Parameters | ' = Application J | 2) |
. . b ' D Statistics )

3. Post-processing and result analysis ' forimental) | Simulation | | | ;
. . . D Setti I Kernel || ' L- Visualization) '

~- Each simulation is only a brick e e ) et |

Workload Generation
> Platforms: Simulacrum (generation), PDA (archive) and MintCAR (mapping)
> Applicative Workload: Tau-based trace collection + replay

Topology ‘Topological Blank
Model l Graph l Platform N Labelling

Generation Promation

XML
e Experimental
X a:-::ﬁ:.c Setting Graph
Selection
Description
Real World ot
Platform - o
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Max-Min Fairness between Network Flows

cPU; CPU, x1 < Power_CPU; (1a)
@ linky link; X2 + x3 < Power_CPU,  (1b)
o e p1 + p2 < Power_link; (1c)

p1 + p3 < Power _link, (1d)

Computing the sharing between flows
> Objective function: maximize rfm;(pf) [Massoulié & Roberts 2003]
€

» Equilibrium: increasing any pr decreases a p} (with pr > pf)
> (actually, that's a simplification of our real objective function)

Efficient Algorithm

1. Search for the bottleneck link / so that: % = min {Sk, k € £}
I k
C/

2. This determines any flow f on this link: pr =
3. Update all n; and C; to remove these flows; Loop until all pf are fixed
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Max-Min Fairness Example

Homogeneous Linear Network

flow 0
link 1 link 2
Po =
flow 1 flow 2 pL =

> All links have the same capacity C
» Each of them is limiting. Let's choose link 1
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Max-Min Fairness Example

Homogeneous Linear Network

flow O
link 1 link 2

T po = C/2

flow 1 flow 2 pL = C/2

P2

> All links have the same capacity C
» Each of them is limiting. Let's choose link 1
= po = C/2 and p1 = C/2
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Max-Min Fairness Example

Homogeneous Linear Network

C1: n1:0
G=C/2 =1
| eSSy T
F }1 po = C/2
flow 2 p1=C/2
P2 =

> All links have the same capacity C

» Each of them is limiting. Let's choose link 1
= po=C/2and p; = C/2

» Remove flows 0 and 1; Update links’ capacity
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Max-Min Fairness Example

Homogeneous Linear Network

N w [ =~
o |

po = C/2
pP1 = C/2
P2 = C/2

> All links have the same capacity C

» Each of them is limiting. Let's choose link 1
= po=C/2and p; = C/2

» Remove flows 0 and 1; Update links’ capacity
> Link 2 sets p; = C/2.

» We are done computing the bandwidths p;

Efficient Implementation
» Lazy updates, Trace integration, preserving Cache locality
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The CPU model in a Nutshell

Modeling computations in SimGrid

CPU = rate R in Mflop/s @& Computation = amount A of Flops ~ Time = A/R

Simulation kernel main loop

1. Some actions get created (by application) and assigned to resources

Simulated time.
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The CPU model in a Nutshell

Modeling computations in SimGrid

CPU = rate R in Mflop/s @& Computation = amount A of Flops ~ Time = A/R
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CPU = rate R in Mflop/s @& Computation = amount A of Flops ~ Time = A/R

Simulation kernel main loop
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CPU = rate R in Mflop/s @& Computation = amount A of Flops ~ Time = A/R

Simulation kernel main loop
. Some actions get created (by application) and assigned to resources
. Compute share of everyone (resource sharing algorithms)

1
2
3. Compute the earliest finishing action, advance simulated time to that time
4

. Remove finished actions
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CPU = rate R in Mflop/s @& Computation = amount A of Flops ~ Time = A/R

Simulation kernel main loop
Some actions get created (by application) and assigned to resources
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The CPU model in a Nutshell

Modeling computations in SimGrid

CPU = rate R in Mflop/s @& Computation = amount A of Flops ~ Time = A/R

Simulation kernel main loop

Some actions get created (by application) and assigned to resources
Compute share of everyone (resource sharing algorithms)

Compute the earliest finishing action, advance simulated time to that time
Remove finished actions

Loop back to 2

ok W=

In addition in SimGrid

» Availabilities & Failures
Traces and Generators

» Sharing for networks is
a bit more complex

Simulated time.

Martin Quinson Computational Science of Computer Systems Introduction €S2 SimGrid PDES Formal Open Science  Conclusion 42/30



How big and how fast? (1/3 — Grid and VC)

Comparison to GridSim
A master distributes 500, 000 fixed size jobs to 2,000 workers (round robin)

GridSim ‘ SimGrid
Network model | delay-based model | flow model
Topology none Grid5000
Time 1h 14s
Memory 4.4GB 165MB

Volunteer Computing settings
» Loosely coupled scenario as in Boinc
> SimGrid: full modeling (clients and servers), precise network model
» SimBA: Servers only, descisions based on simplistic markov modeling

~> SimGrid shown 25 times faster
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How big and how fast? (2/3 — P2P)

» Scenario: Initialize Chord, and simulate 1000 seconds of protocol

> Arbitrary Time Limit: 12 hours (kill simulation afterward)

40 000

Oversim (OMN&T++ undérlay Largest simulated scenario

Oversim (simple underlay

) ——
) ——
)—E'— Simulator | size | time
) —

P

12}
£ 30000 sﬁ;‘gﬁ{;%ﬂ;ﬂﬁgggﬂ OverSim (OMNeT+—+) | 10k | 1h40
% OverSim (simple) | 300k | 10h
S 20000 || ] PeerSim | 100k | 4h36
g 10k | 130s
g SG (flow-based) | 300k | 32mn
é 10 000 | B 2M* | 6h23

SG (delay-based) | 2M | 5h30

0 : : : ~ % 36GB = 18kB/ process (16kB for the stack)
500 000 1e+06 1.5e+06 2e+06

Number of nodes

» Orders of magnitude more scalable than state-of-the-art P2P simulators

o

» Precise model incurs a ~ 20% slowdown, but accuracy is not comparable
> Also, parallel simulation (faster simulation at scale); Distributed sim. ongoing
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How big and how fast? (3/3 — HPC)

Simulating a binomial broadcast

10000 ————— Model:
1000 L ] » SimGrid: contention + cabinets
hierarchy
100 |

» LocGOPSIM: simple delay-based model
10
Results:
1 -

Simulation Time (s)

» SimGrid is roughly 75% slower

01} LogGoPSim —+— » SimGrid is about 20% more fat
SimGnd (15GB required for 2%* processors)

0.01

10 12 14 16 18 20 22 24
Log, of the Number of Processes

The genericity of SimGrid data structures comes at the cost of a slight overhead

BUT scalability does not necessarily comes at the price of realism
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Contributions to Experimental Facilities (in vivo)

Grid'5000 Project: world leading scientific instrument for dist. apps

> Instrument for research in computer science (deployment of customized OSes)
1500 nodes (2800 cpus, 7200 cores), 9 sites; dedicated 10Gb network

e

Application

: Programming Environments §

""" Application Runtime §

Grid or P2P Middleware
Operating System é

Networking

Experimental conditions injector

Personal Contributions
> National steering committee; Local project co-leader (CPER, Aladdin, Hemera)
» Scientific animation, event co-organization: Nancy is a leading site
» Collaboration: Production grids (IdG), CEA, Arcelor-Mittal

Project: Experimentation Process Industrialization (with L. Nussbaum)
» Open science: ensure that experiments can be shared, reviewed, improved
» Convergence of simulation and direct execution

» Methodological framework and practical tools (+administrative duties)
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One Methodology to Rule Them All

Analyse (Viz., Data Mining)

Answer Reality ————————, Understanding
a question Facts ——_ — Hypothesis
Test (DoE, MC)
Describe one U’
] experiment Experiment description
#
©
2
& R
2 un one Home-made XPFlow (no need for complex runner)
Es} experiment
2
5 0
= s i Topolo Distem Model-checking
ensors p
- . &y G5K Monitoring infra Models | — exhaustive simulation
& actuators script
> — tactical simulation
L
Cl d
Substrate / UStejrno ° Grid'5000 HP Simulation
hardware ) " Virtualization/Folding
switches

Several scientific instruments implementing different scientific methodologies
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Médiation scientifique

Sciences Manuelles du Numérique

>

v

Faire des activités d'initiation a la science informatique
Pour la féte de la science, pour les TS (1/3 du temps hors machine)

Boolier: Codage binaire de I'information, code correcteur, transmission
Crépier psycho-rigide: Notion d'algorithme, tri
Base-ball coloré: Algorithme, algorithme efficace, algorithme correct

Robozzle: Programmation (instruction, boucle, fonction)
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